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ABSTRACT 
Augmented Reality (AR) is a powerful platform that combines virtual objects and 
information with real time surroundings. Even though its underlying concepts may 
resemble virtual reality, AR devices have the potential for mixed reality, where virtual 
objects can interact with real surroundings. The Epson Moverio BT-200 is digital 
eyewear capable of producing AR. Its dual screen glasses were cutting edge at their 
time of release and provide an AR experience using their many sensors. Our study 
explored the intricacies of working with AR using the Epson Moverio BT-200. The 
software and hardware capabilities of these glasses were explored and then illustrated 
through the design and implementation of a number of proof-of-concept and prototype 
AR applications. These applications were tested and evaluated to scope the possible 
uses of AR technology in support of our research into Land Logistics and in support of 
Land Logistics more generally. 
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Summer Vacation Placement LD04: Investigating the 
Utility of Augmented Reality for Land Logistics  

 
 

Executive Summary  
 
 
This report documents the outcomes of an investigation into the utility of Augmented 
Reality (AR) for Land Logistics and Combat Service support, under Defence Science and 
Technology Group’s 2016/17 Summer Vacation Placement program. The investigation 
was carried out by two students, Chelsea Fortuna (on a 6 week placement) and Matthew 
Howe (on a 12 week placement).  

AR has been an emerging technology for a number of years and rapid development in 
hardware and software surrounding this technology now mean that potential applications 
are being developed within Defence. This report documents the exploration of the use of 
the Epson Moverio BT-200 AR glasses in a Land Logistics setting and beyond. 

Through the course of this investigation a number of applications of AR were conceived, 
built and/or tested. These applications included an inventory management app, a 
‘MedicAssist’ app, a 3D visualisation tool, and a mechanic tutorial app. Other applications 
that were not developed or tested in full include terrain visualisation/ simulation, route 
tracking/optimisation, tele-assistance/tele-operation, invisible armour, and a war 
game/simulator for training purposes. These ideas encompass some of what Defence 
could utilise this technology for in the future. 

Through this investigation it was found that often the Epson Moverio BT-200 AR glasses 
were insufficient for visualising complex 3D scenes; however, they can be used for 
applications where hands-free information, and simple animations/images and videos 
need to be presented to the wearer. Other AR hardware such as the Microsoft HoloLens 
and Google Glass should be explored for more demanding applications although these 
both have their pros and cons which need to be considered before purchasing and 
deploying.  
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1. Introduction 

Augmented Reality (AR) is a technology that has the potential to transform the way many 
activities are carried out in Defence. A Summer Vacation Placement (SVP) project was 
established by the Land Logistics group to investigate the utility of AR technologies for 
Land Logistics and Combat Service Support (CSS) activities. The investigation was 
conducted by two Summer Vacation Placement students, Chelsea Fortuna (on a 6 week 
placement) and Matthew Howe (on a 12 week placement).  

1.1 Aims and Objectives 

Our initial interest in AR was twofold: as a technology in its own right to assist with 
logistics, and for its potential utility to increase engagement with stakeholders through 
more effective communication of concepts and ideas. From this, the SVP project arose as a 
means to begin the exploration of AR for these two purposes. The specific aim of the SVP 
project was to investigate the utility of a particular manifestation of AR, namely the Epson 
Moverio BT-200 AR glasses, and to use the insights gained to draw more general 
conclusions around the utility of AR for these two purposes. The investigation included 
gaining an understanding of the technical capabilities, affordances and constraints of these 
AR glasses, developing ideas for their application to logistics and CSS activities, and 
building proof-of-concept and prototype software applications for the glasses for 
evaluation.  

1.2 Augmented Reality Definitions 

We begin with some definitions to provide context. In this report, we have provided a 
breakdown of definitions along the progression from ‘actual’ reality through to virtual 
reality, based on the reality-virtuality continuum given in [1].  

• Actual Reality: Real environments—what we see and experience with our eyes 
every day, without alteration or augmentation. 

• Mixed Reality: The combination of real and virtual worlds. This may or may not 
include some degree of interaction between the real and virtual components. The 
superposition of textual information (contextual or otherwise) overlaid on a real 
environment is an example of mixed reality with little or no interactivity between 
the real and virtual components. A virtual ball rolling off the table onto the ground 
is an example of interaction between the virtual component (ball) and real 
components (table and ground). There are two main subcategories of mixed reality: 

o Augmented Reality: The incorporation virtual objects and information 
within a real environment.  

o Augmented Virtuality: The incorporation of elements of a real 
environment within a virtual environment.  
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• Virtual Reality (VR): A completely synthetic environment within which the user is 
totally immersed and able to interact. 

1.3 Epson Moverio BT-200 

The Epson Moverio BT-200, pictured in Figure 1, was released in 2014 and is an Android 
digital eyewear device. The BT-200 glasses comprise a wearable headset physically 
tethered to a hand-controller unit, as pictured. Full specifications can be found at [2].   
 

 
Figure 1 Epson Moverio BT-200 glasses (image via [3]) 
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2. Background Research 

At the start of the placement the team had a general awareness of AR but limited 
knowledge of the BT-200 glasses. A summary of research on both the device itself and on 
AR application (‘app’) development is given below.  

2.1 The Device 

As mentioned above, the BT-200 glasses have a range of sensors and functionalities. The 
following section details and evaluates each of these capabilities individually. Technical 
details can be found at [2]. 

2.1.1 Sensors  

The BT-200 glasses are equipped with a Global Positioning System (GPS) receiver in the 
headset and a compass, accelerometer and gyroscope in both the headset and controller. 
The quality and accuracy of each of these sensors is comparable to those on a modern 
smart phone. The data from these sensors can be accessed by an application in the same 
way as on any Android device, making it a suitable platform for application development. 
Some difficulty was encountered when trying to access the sensors in the hand controller 
unit instead of those in the headset. This may be because the presence of multiple 
accelerometers and gyroscopes is something not usually found in common Android 
devices such as smart phones and tablets, and hence software development packages for 
Android may not handle this well. 

2.1.2 Camera 

There is a 0.3 Megapixel camera mounted on the bottom right of the headset (from the 
perspective of the wearer). This is a reasonably low resolution relative to other smart 
devices manufactured at around the same time e.g. the iPhone 6 with an 8 Megapixel rear 
camera [4]. We speculate that a lower resolution camera may have been used to reduce the 
price of the product for consumers or to reduce the size of the headset. Regardless, it has 
been observed that the camera in the headset takes longer to recognise targets/markers 
(for localisation) than a Samsung tablet of similar age, a more modern Samsung phone or a 
Microsoft Surface Pro 3. Its delay in recognising objects may not be solely due to the 
reduced resolution, but also the following factors:  

• The device has less processing power than e.g. the Samsung tablet or Surface Pro 3, 
and so may take longer to process images 

• The low resolution of the camera may result in increased human error, as our 
experience was that combination of the off-centre location of the camera and low-
resolution images sometimes made it difficult to tell when the target was properly 
within the camera’s field of view 
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2.1.3 Memory 

In terms of internal memory, the hand controller unit has 1 gigabyte (GB) of working 
memory and 8 GB of internal storage. The controller also allows up to 32 GB of external 
storage through a micro SDHC card slot. The networking capabilities discussed later also 
provide the opportunity for off-board to on-board transfer of large data from external 
sources such as online databases. 

2.1.4 Networking 

The device has wi-fi and Bluetooth capabilities (although not Bluetooth Low Energy). It is 
said to be compatible with Miracast [5] to provide screen mirroring, but we were unable to 
get this working without proprietary Epson peripherals. We also found that the GPS 
sensor wouldn’t work without wi-fi turned on, but we have not confirmed the reason, nor 
whether this is an intentional feature of the BT-200. 

2.1.5 Battery Life 

The battery life is approximately 6 hours for general use. We have observed that 
displaying 3D images and extensive network communication (e.g. wi-fi) will drain the 
battery significantly more quickly. 

2.1.6 3D Mode 

The device has 2D and 3D capabilities. It supports a side-by-side 3D format and for best 
performance a calibration profile should be made for each wearer. A simple way to do this 
is to download the Calibration App by Vuforia from the Vuforia website [6]. 

2.1.7 Virtual Screen  

The angle of view is 23 degrees, meaning a 40”screen can be projected at a distance of 
2.5 metres. It is large enough for viewing images and basic information but is not suitable 
for immersive experiences or for displaying fine details (e.g. paragraphs of text). This 
limitation is not unique to the BT-200, and although AR glasses that can achieve greater 
fields of view are beginning to be released, none can claim to be fully immersive.  

2.1.8 Accessories 

Tinted inserts are supplied for outside use or can be used to block out the user’s 
surroundings. For a more realistic augmented reality effect, it is recommended that 
sunglasses are not worn. Ear hooks are included as well as flexible nose pads to secure the 
headset. A lens holder is included for users that require regular prescription lenses, such 
that prescription lenses can be inserted directly into the BT-200 glasses. The device does 
not have an internal speaker, although audio can be played through an audio jack on the 
device. Earphones are supplied which also include a microphone, which may be useful for 
speech recognition in hands-free applications. 
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2.2 Augmented Reality Application Development 

Following an investigation of the features of the BT-200 glasses, we explored the broad 
area of application development and then focussed more specifically on AR applications 
for the BT-200. This was a relatively new field for the Land Logistics group at DST Group, 
where there was little prior knowledge or development on the topic. Thus, research in the 
areas of software development platforms, device set up and application adaptation for the 
BT-200 was undertaken. 0 contains some of the resources we found useful and documents 
our troubleshooting of the issues we encountered. 

2.2.1 Platforms 

Unity3D [7] and Unreal Engine [8] were the most prevalent application development 
platforms on the web, both with the ability to incorporate augmented reality plugins. 
Unity3D is a high level game engine that specialises in computer graphics. It has useful 
plugins and extensive resources online. Unity3D also included a very easy to use Vuforia 
Augmented Reality plugin. Vuforia is a company that has produced a Unity library (also 
known as a ‘prefab’) for the BT-200 glasses, which is able to be imported into a project and 
called upon to provide functionality. This made Unity3D the favourable choice for 
beginner application development for the BT-200 glasses. In addition to this, there was an 
Epson Moverio plugin that included Moverio Camera Rig and Moverio Controller prefabs 
for use in Epson Moverio apps.  

Unity3D allows the user to create generic applications and then compile them for the 
required platform, whether it be Windows, iOS or Android. It has a refined ‘drag-and-
drop’ style user interface, but when it comes to detailed coding, Unity3D will redirect the 
user to Microsoft Visual Studio (if it is installed). In this project, code was written in C# (C 
sharp) as this is the preferred application development language for Unity3D. In addition 
to installing Unity3D and Microsoft Visual Studio, an Android Software Development Kit 
(SDK) and a Java Development Kit (JDK) were required to be installed and referenced 
when building a Unity3D project. 

2.2.2 Setting up the BT-200 

To allow applications to be installed directly onto the device from Unity through a USB 
port, the device had to be set to ‘developer mode’ with USB debugging enabled.  

2.2.3 Adapting Applications for the BT-200 

The majority of the application development process for the BT-200 glasses was the same 
as that for any other Android device. However, care was taken when displaying 
information on the screen as it has a substantially different aspect ratio to most Android 
devices. Essentially, the screen is split vertically down the middle, with half of the screen 
displayed to each eye. Additionally, when using Vuforia, an app license key specific for 
digital eyewear had to be obtained by signing up to using Vuforia as a developer. 



UNCLASSIFIED 
DST Group-GD-0964 

UNCLASSIFIED 
6 

3. Application Ideas and Evaluation 

Following the investigation of BT-200 capabilities and software development platforms, a 
set of desired functions/capabilities for the BT-200 glasses was generated. The idea was 
that these will provide elements of underlying functionality for incorporation into AR 
applications. The capabilities were: 

1. Bidirectional transfer of data between off-board and on-board storage (via wi-fi 
and Bluetooth capabilities) 

2. Displaying text data: 

a. Static text 

b. Dynamically changing text (from internal or external sources) 

3. Display of 3D objects 

4. Recognising “input” of various forms: 

a. Text 

b. Images 

c. Gestures 

Following this, several possible application ideas were discussed that embody some of 
these capabilities, and are described below. These applications were designed to explore 
potential use cases for AR in Land Logistics. 

3.1 Ideas for Application Development 

Most of the ideas developed during this project revolve around the concept of an 
application recognising an image, object, gesture or text in its surroundings and then 
displaying contextual text, images or objects relevant to that particular cue. In AR such 
cues are called ‘targets’. A target forms the basis for interactive AR as it gives the 
application a real world reference point, which is especially important when using a 
device that has a single camera (like the BT-200) and hence cannot accurately capture a 
sense of depth in an environment. (Other products on the market can achieve this through 
the use of multiple cameras, such as the Microsoft HoloLens.) The following application 
ideas were designed with this limitation in mind. The BT-200 is able to take the input of 
the single camera and (attempt to) track the location of objects by tracking targets. 

3.1.1 Computer Aided Design Visualisation 

The idea of this application is that users could upload Computer Aided Design (CAD) 
sketches to the BT-200 glasses prior to manufacture, to allow their clients to better visualise 
new products before production. 3D visualisation allows the wearer to gain a fuller 
appreciation of how the product will look in real life and a sense of the scale of the whole 
part or assembly, and to interact with the object more intuitively than can be achieved 
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through static 2D drawings. Additionally, different functionalities of the object can be 
demonstrated through animation in the visualisation (e.g. a mechanical assembly).  

As well as describing concepts to stakeholders, this same principle could be used to teach 
people how to perform certain tasks without physical objects being used, so this has 
significant potential utility in the training of equipment operators and maintainers. For 
example, when training a maintainer to service a vehicle, all the steps could be performed 
on a virtual vehicle, without a physical vehicle being present. We explore this further in a 
separate idea on virtual tutorials later. 

3.1.2 Inventory Management 

The next idea was an application to assist with inventory management. The glasses could 
recognise an item and display contextualised information and prompts to the user based 
on the item recognised. For instance, in a stock room setting, the user may look at a 
product and retrieve information such as safety data sheets, perform actions such as 
stocktaking, or record the location of the item so that it can be located again at a later time. 
Another example of this concept could be in a medical scenario, where staff could look at a 
drug before administering it to a patient in order to log the usage of that drug. This may 
make it easier to keep track of inventory and potentially assist with accurate reordering. 
The hands-free aspect of AR glasses (vs. augmented reality delivered via smartphone or 
tablet) makes this particularly attractive, as most medical staff require both hands to carry 
out their work.  

The function of providing contextualised display (and recording) of drug information at 
the time and place of relevance is but one possible use in this context. Often time is a 
critical element in the survival and effective care of patients. The current system of bells, 
rolling text displays in hallways and announcements via overhead speakers that are used 
to get nurses attention immediately may not be the most efficient method of delivering the 
information needed. AR glasses offer an alternative for the delivery of contextualised, 
individualised information to individual medical personnel, rather than being announced 
to everyone in the building. 

3.1.3 Virtual Tutorials using Graphical Overlay 

The third idea was using AR to assist with repair, diagnostics and assembly tasks, so that 
technical tasks can be performed by untrained personnel. For instance, the driver of a car 
that is experiencing engine problems could put the glasses on and look at the engine bay. 
The glasses could then overlay information onto the car about specific components the 
driver should check, or things they should do. The graphical overlay could include arrows 
and circles around parts so that even someone with no previous experience is able to, for 
example, conduct a vehicle service to an adequate standard (given they have the 
appropriate tools to hand). In this case, as with the previous one, having a hands-free 
solution like the BT-200 is particularly beneficial.  

This type of application has relevance to Land Logistics in the maintenance area, both for 
training maintainers, but also for providing interactive, hands-free maintenance manuals. 
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Such manuals could also be used in tele-maintenance, to assist non-maintainers to perform 
critical tasks to repair their vehicles if they break down while on a mission, with specialists 
providing advice and assistance remotely.  

3.1.4 Route Tracking and Recording 

From the authors’ previous experiences a particular use for AR could be in driver training. 
For example, a team of analysts could investigate the optimal path for a racing car to take 
to maximise speed and win a race. The driver of the car could, through AR glasses, have 
this optimal path projected onto the track, with other information such as recommended 
speed, brake timing, and apex location. 

This idea would work in a similar way to existing GPS navigation style applications. 
However, it has the advantage of being able to project the recommended route onto the 
ground in front of the user, which may be easier to follow than a non-head-mounted 
solution. A particular application may be for Army combat vehicles going through rough 
terrain, or resupply convoys traversing difficult or complex road networks (e.g. contested, 
congested urban environments). The driver could wear the glasses and steer the vehicle 
down the path of minimal disturbance/least resistance by following a sequence of virtual 
waypoints, either pre-defined or recorded by previous exploratory vehicles that traversed 
the same terrain/road network. 

3.1.5 Tele-Assistance 

In most of the applications suggested within this report, a need to speak to a professional 
may arise. It may be possible to speak with people remotely, and for them to annotate the 
world around you. For example, it may be that a remote expert can draw an arrow or a 
circle to point out the object you need to look at or inspect, as a way of augmenting verbal 
instructions. This has application in both tele-maintenance and tele-medicine, where 
professionals may be able to provide assistance to deployed forces without having to be 
physically deployed themselves. 

3.1.6 Base Deployment, Planning and Training 

This idea was about providing the ability to take terrain data, such as topographical data, 
and show this to a user. This idea is more of an enabling application for other end 
products than an end product in itself, but the development of this opens up possibilities 
such as higher-fidelity battle simulations or the ability to plan the layout of a deployed 
base in a particular location before physically citing it. 

3.1.7 Simulation Visualisation 

After attending the 2017 DST Group Student Conference it became apparent that the 
integration of AR into simulation tools for the visualisation of results would offer a 
significant benefit, both internally within DST Group and in the Australian Defence Force 
more generally. This would involve the adaptation of current simulation software to 
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interact with AR glasses. The BT-200 glasses may be suitable for visualising the results of 
simulation tools. 

3.1.8 Invisible Armour 

Similar to the use of AR in F-35 helmets, where the pilot is able to see through the cockpit 
and detect surrounding targets, this could also be applied to vehicles which currently have 
very limited vision such as tanks. This would involve the implementation of external 
cameras on the vehicles. 

3.2 Evaluation of Ideas 

In this section the strengths and weaknesses of the above ideas are evaluated in terms of 
their potential suitability for implementation on the BT-200 glasses. In some cases this 
involved the development of rudimentary proof-of-concept applications, some of which 
were subsequently further developed (see Section 0). Some suggestions for improving the 
application ideas in the future are given. 

3.2.1 CAD Visualisation  

This application was built and tested on the BT-200 glasses. Navigation throughout the 
application worked well, such as scene changes, user interface buttons and check boxes. 
Visualising objects that remain static within the field of view of the user also worked: the 
object was clearly visible, it was obviously 3D, and the movement of objects within the AR 
display had little lag. However, navigation around the object (i.e. the user physically 
moving around the virtual object) did not function well due to poor target tracking on the 
part of the BT-200. We suspect this is related to the low resolution of the camera (as noted 
in Section 2.1.2). When visualising an object using a target as the detection point, the user 
would often experience lag – the 3D object would appear to move with the user and then 
jump back to its intended location above the target. The application also had a tendency to 
crash completely when visualising complex objects. This application also tested some 
animation of objects, but these also returned poor results in terms of lag and stability of the 
application for complex objects. 

3.2.2 Inventory Management 

This application was attempted for the BT-200 glasses to aid in stock location by directing 
a user towards an indoor location. The use of the built in sensors was implemented as a 
way to track location, direction, and distance from the reference point of the glasses. 
Sensors tested included the compass, accelerometer, gyroscope and GPS. Although some 
of the sensors did function in an appropriate way, other sensors such as the GPS were 
irregular in the indoor laboratory environment in which this project took place. (Note that 
we did not attempt to implement GPS-independent inertial navigation due to time 
constraints.) This made it difficult to represent indoor location information in an organised 
way that would provide a benefit to the user. The sensor functionality limitations are 
likely to be localised to using these particular AR glasses and to the particular test 
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environment (limited visibility of the sky and hence limited GPS signals). Other hardware 
solutions and/or operation in other environments may prove more successful.  

3.2.3 Virtual Tutorials 

This application was built and tested for the BT-200 glasses using the specific example of 
vehicle servicing. It implemented one task (oil change). This application worked well in 
terms of navigation through the application but was not ‘hands-free’ as the hand controller 
unit for the glasses was needed to navigate through the application. In future, navigation 
could be by voice command, removing this limitation. We intended the application to 
feature a demonstration function which would allow the user to see the steps being 
performed on a 3D model. However, the application crashed each time the model was 
loaded. This may be due to the amount of computer memory needed to store the complex 
engine assembly model. Besides this issue, this application has the potential to be 
developed further and implemented more fully. 

3.2.4 Route Tracking and Recording 

This application was not built or tested, however aspects supporting its implementation 
were. This application may work well if implemented in a well thought out manner. The 
path information does not necessarily need to be displayed as a graphic overlay, as it 
could simply have a 2D direction and pointer visualisation that would work on 2D AR 
hardware such as Google Glass. The application could also be implemented in 3D AR 
hardware where the path is highlighted in front of the user. Depending on the accuracy 
required, one potential issue with an application of this nature is the accuracy of civilian 
GPS positioning for reproduction of a route. It is likely that military-grade global 
positioning or other forms of localisation (such as inertial navigation systems or optical 
tracking) would be required to attain the desired level of accuracy. It is known that even 
advanced AR devices such as HoloLens, that do utilise multiple mechanisms for 
localisation, struggle to maintain coherent positioning when used in outside locations. 
Hence, this application may have to wait until more capable AR hardware is available. 

3.2.5 Tele-Assistance 

This application was not built or tested, nor were aspects supporting its implementation. 
However, evidence in the open literature1 suggest that applications such as this are 
eminently possible with current AR hardware such as Google Glass, HoloLens and Meta 2, 
and could be tailored to suit a specific application (e.g. tele-medicine or tele maintenance). 

3.2.6 Base Deployment Visualisation 

This application was partially built and tested on the BT-200. The application was a simple 
proof-of-concept for this particular AR hardware. A similar application was later seen 
during a visit to Saab Australia, where they demonstrated a 3D map of an island, with 
                                                      
1 e.g. https://www.theguardian.com/business/2016/sep/19/hololens-the-virtual-reality-headset-for-
elevator-repair  

https://www.theguardian.com/business/2016/sep/19/hololens-the-virtual-reality-headset-for-elevator-repair
https://www.theguardian.com/business/2016/sep/19/hololens-the-virtual-reality-headset-for-elevator-repair
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planes, ground vehicles, ships and troops deployed in the area in a wargame simulation. 
This was implemented using Microsoft HoloLens. The demonstration provided 
confirmation of both the viability and potential utility of a base deployment visualisation 
application.  

3.2.7 Simulation Visualisation 

As with the base deployment application, this application was partially built and tested on 
the BT-200. The use of AR has a lot of potential for the visualisation of simulations. This 
could include war gaming/training, where the user is able to be trained in an outside 
environment rather than through a purely synthetic (i.e. VR) means.  

3.2.8 Invisible Armour 

This application was not built on the BT-200. See-through or invisible armour could be 
implemented through either virtual or mixed reality, depending on the particular 
application. One potential problem could be that the processing of large camera feeds may 
cause the VR/AR device to operate slowly, but could be mitigated by restricting the 
‘invisible’ field of view to a small area similar to the size of a vehicle windscreen, or 
offloading the heavy processing to computing devices external to the VR/AR device.  

3.3 Observations 

Most of the above ideas rely on using targets/markers in the real surroundings to provide 
localisation, as is required for the BT-200 to function in this way. The targets were also 
used to influence what would be visualised on the screen, through image or text 
recognition of the targets themselves. It was found that the use of targets, such as image 
and text, was the most consistent type of target detection when using the glasses. So-called 
‘marker-less’ augmented reality, achieved through geolocation and other forms of 
localisation, was found to be unreliable with the BT-200 glasses, as it requires position data 
that is consistent and accurate. Apart from the inaccuracies inherent in civilian GPS (a 
precision of 5-10 metres) the laboratory environment within which this research took place 
afforded a limited view of the sky. For a precision application such as stockroom location, 
geolocation via GPS or equivalent is not sufficient, and would require augmentation with 
alternative means of precisely determining location. HoloLens, for example, has such 
capabilities. Exploring the implementation of such capabilities for the BT-200 was beyond 
the scope of this project.  

Furthermore, after some testing it became obvious that the BT-200 glasses struggle to 
identify targets when they are too far translated from their expected shape or orientation. 
We believe this is due in large part to the low resolution of the BT-200’s camera. This could 
cause some difficulties for the accurate detection and identification of inventory in 
inventory management applications (such as drug packaging in the MedicAssist 
application in 4.2). Another example would be in virtual tutorials, for example, where each 
engine bay may look slightly different, due to dust and orientation of the view. In order to 
have the BT-200 recognise different engine bays, specific 3D models would be needed for 
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each specific model of vehicle. However, a simpler approach could be taken to make a 
virtual tutorial for one particular type of engine bay. More advanced techniques, such as 
the application of machine learning to identify multiple types of engine bay (and engine 
components therein), are beyond the scope of this report.  

Locating supplies seems to be one of the most promising ideas for AR, as DHL and Ricoh 
have already tested this for stock picking applications in their warehouses using Google 
Glass. This application displays information about where products are located but does 
not actually guide you to their location. Although simple, this application is useful, and 
has been proven to increase productivity. Figure 2 shows DHL’s application in action, 
where it is used to help stock pickers load trolleys correctly and more efficiently. Thus it 
may be better to generate a slightly different application, one that focuses on stock location 
querying and guidance, rather than purely on stock location. 

The CAD Visualisation application is one way of attempting to use AR to increase 
engagement with stakeholders through more effective communication of concepts and 
ideas. Using this, researchers can facilitate a greater understanding on the part of the 
stakeholders of a concept or product. Thus, CAD visualisation appears to be a worthwhile 
augmented reality tool to develop further.   
 

 
Figure 2 Augmented Reality Stock Picking Application in use at DHL (image via [9]) 
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4. Application Implementation 

After consideration of the project objectives and AR device constraints, the following 
applications were developed. As the SVP placement was framed as an exploration of 
technology with no specific application in mind, each application was presented as a 
proof-of-concept/prototype rather than a fully functional polished application. Each 
application implemented an idea from Section 3. Due to time restrictions, the decision was 
made to develop applications that could be used as a starting point for more complex 
applications. As such, the applications were intended to be relatively open so as to 
facilitate future work and extension. Potential extensions are discussed in Section 5. 

4.1  Inventory Management 

The first application that was successfully developed, built and executed was the 
inventory management app for use in warehouses. Screenshots are shown in Figure 3. This 
is an app that uses a 2D overlay of information within the field of view. The app can 
provide warehouse personnel with inventory information immediately about a particular 
product by recognising a product using the BT-200’s camera. Fundamentally, the wearer 
can scan an item in a stockroom by looking at it with the glasses on, and then the glasses 
present the wearer with product-relevant information. The application’s menu has three 
options: Properties, Stocklist, and Location. The Properties button displays an 
identification number of the scanned product and product description to the user for 
viewing and editing. The Stocklist button is versatile and can be used perform stocktake or 
add a list of products to an order. The user would simply have to go around looking at the 
desired products with the glasses on and they would be added to a list for future 
reference. The final option, Location, allowed the user to record the location of a product 
in a warehouse using GPS and compass data from the device, or through manually-
entered location information. This would be useful when an employee wants to find an 
item that’s been relocated or plan where there is empty space to place a new product. 
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Figure 3 Screenshots of the Inventory Management app recognising text  

 

4.2 MedicAssist App 

This application uses the same underlying concept as the previous Inventory Management 
application of item recognition leading to relevant information display. It is intended to 
assist medical staff when administering medication in hospitals, and is shown in Figure 4. 
A doctor, nurse or pharmacist could wear the glasses and look at a product to recognise it. 
Relevant information about the product is then displayed and the user can then select to 
know more information or simply continue. This also has application in tele-medicine, 
where this application could also be implemented with a Skype-like call scenario where a 
doctor can guide a user through steps, by watching through the camera of the device to 
see what the user is seeing. Whether or not this is possible with the BT-200 glasses, and if 
so, how difficult it would be to implement, is beyond the scope of this paper. 
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Figure 4 Screenshots from the MedicAssist App  

 

4.3 CAD Visualisation App 

This application was a simple proof-of-concept to check the viability of looking at 3D 
objects through the glasses. Some examples are shown in Figure 5. This application also 
served as a basis for the base deployment visualisation application (see Figure 6). 
Although this application works, it did not work as well as expected when adding 
multiple virtual objects into the scene, as the BT-200 glasses struggled to keep track of 
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them. There were also difficulties visualising terrain models, not through technological 
limitations but because we were unable to obtain 3D topographical data in the timeframe 
required. The graphics processing capabilities of the BT-200 glasses also appear to be 
substantially limited. Attempts to display complex animations and objects resulted in a 
jerky, low refresh rate visualisation, and if a quick movement of the user’s head occurred 
the object could ‘jolt’ or get lost in the surrounding space, and not track correctly against 
the target. 

 
 

 
 

 
Figure 5 Screenshots of the CAD Visualisation App 



UNCLASSIFIED 
DST Group- GD-0964 

UNCLASSIFIED 
17 

 
 

 
Figure 6 Screenshots of the CAD Visualisation App demonstrating the potential for Base 

Deployment visualisation applications  
 

4.4 Mechanic Tutorial App 

This app builds on the CAD Visualisation app. The app runs through a simple tutorial of 
performing the removal of an oil filter from an engine, which includes the following four 
steps with instructions:  

1. Materials needed 

2. Place oil tray under engine 

3. Remove oil sump 

4. Remove oil filter.  
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This app works well, and it is an accurate proof of concept of the application. We 
attempted to add a feature to steps 2-4 to display an animated demo of the steps being 
performed. However, the glasses could not keep up when displaying the complex engine 
assembly and crashed each time this was attempted. This process can work but may 
require more development time, and/or a different AR device with more computing 
power. As can be seen in Figure 8, the instructions are placed around the field of view of 
the user as an attempt to minimise the obstruction of view.   
 

 

 
Figure 7 Screenshots from the Mechanic Tutorial App (without the real world backdrop) 
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Figure 8 Attempts to incorporate animation within the Mechanic Tutorial App 
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5. Reflection 

The following section provides our reflections on the performance of each application and 
specifically its limitations, potential improvements and options for future work. In general 
the applications were fine as proofs-of-concept of the ideas, but would not work well for 
complex applications. If simple hands-free applications are desired, the BT-200 may be 
able to provide that capability.  

5.1 Applications 

5.1.1 Stock Picking App 

Currently, this application uses text recognition to identify an ID number that would be 
assigned to each product. This could be improved to identify a barcode or serial number 
instead, which may already be present on every product. This would make the application 
easier to implement as new ID numbers do not have to be assigned to each product, 
attached and updated in a database. Alternatively, a separate handheld barcode scanner 
could be integrated with the glasses to provide identification. 

It was desired for the application to guide a user through a warehouse and locate stock. 
With the BT-200 glasses it was not possible to use location data other than the GPS in the 
time available, however this could be implemented in the future but may not work well 
due to the particular limitations of the BT-200 glasses (e.g. HoloLens provides much more 
sophisticated localisation capabilities). GPS can provide approximate position data, 
however in the application of stock location there was no simple way of attaining the 
accuracy required. The stock application could still be used to display information and this 
was achieved as a possible use for the BT-200 glasses. There is also the possibility of using 
separate sensors to triangulate the position of the user when tagging a location of an item 
of stock, then using that data to locate it. This however was out of the scope of the project. 

5.1.2 MedicAssist App 

The MedicAssist application currently has simple functionality. This was a proof of 
concept built to test algorithms and a method of developing applications. In the future, the 
following extensions/improvements should be considered: the implementation of an 
improved user interface; an expanded version targeted at doctors as well as nurses; simple 
algorithms to learn the usage rates of medicines and to automatically reorder them 
appropriately; an audio-only version that does not block nurses’ vision; improved 
acquisition and display of patient data; and the use of hand gestures and voice recognition 
for controlling the app. These are all functionalities which may be useful in this type of 
application in the future. 
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5.1.3 CAD Visualisation App 

This application would suit AR hardware that is capable of performing faster graphics 
processing so that models of higher fidelity can be visualised more accurately, and 
without lag. A simple mechanism for the transfer of CAD models into the application will 
need to be developed in order to make the application simple to use. There are many ways 
to improve the user interface which can steer away from using the hand controller unit, 
like gesture recognition and voice recognition. 

5.1.4 Mechanic Tutorial App 

This application would suit a HoloLens, where in-depth detail can be shown with 3D 
models, or simply a Google glass application where only a 2D information overlay is 
shown with basic instructions and check boxes. This application has been built specifically 
for the BT-200. By having text away from the centre of the viewing screen, the user is able 
to look through the glasses easier than if the text covered the screen. The use of the hand 
controller unit is still required and future work could involve incorporating gesture and 
voice recognition for hands-free operation. This could be as simple as saying “next” to 
progress the tutorial to the next step. 

5.2 Future Work 

5.2.1 Testing of Usability and Efficacy 

Within DST Group there has been previous research into the application and efficacy of 
virtual reality. It may be useful to undertake this kind of testing to estimate the benefits of 
implementing augmented reality for particular applications by testing the underlying 
principle of the application. For a 3D visualisation application, this might be creating an 
application that can simulate an assembly process and then getting participants to perform 
the assembly, and compare this to the performance of participants that learn the assembly 
process through a set of written instructions, either hard-copy or on a tablet. This kind of 
testing should reveal whether or not such an application can readily increase training 
efficacy and outcomes. 

5.2.2 Polished App Implementation 

Currently the apps that have been developed are proofs-of-concept and prototypes only, 
and are not final polished apps. In the future, once specific target applications are 
determined, targeted development effort can be applied to further developing proofs-of-
concept and prototypes into polished apps. This is possible with the BT-200 glasses, but 
will require resourcing. 
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6. Conclusion 

At the time of their introduction in 2014, the Epson Moverio BT-200 AR glasses presented 
a reasonable AR package suitable for a range of applications. Even today, we found that 
users are able to easily see through the glasses, which means they can still be comfortably 
worn while switched off, as well as while information is being shown. However, three 
years is a substantial amount of time in terms of technological development, and 
consequently the glasses are somewhat dated in functional terms, particularly with respect 
to camera resolution and processing power. The visualisation of dynamic objects attached 
to targets should be used with caution, as we found that the processing power in the 
glasses was not sufficient to keep up with target tracking and displaying the 3D objects. 
This was increasingly our experience as the 3D object models became more complex. For 
this reason, these glasses may be best suited to static text applications or 
display/animation of simple 3D objects. Users will also need to be aware that the display 
does block their primary vision, which will need to be accounted for in the design of any 
application. 

The hardware requirements for augmented reality applications will vary, and there is not 
one piece of hardware which will perform well in every application. Hence in order to 
effectively buy hardware for an application, the application will need to be scoped, if not 
well defined, prior to buying the hardware. Things to consider are processing power, 
weight, battery life, field of view, software compatibility, and integration with other 
hardware/software that may be required. 

In terms of applications for AR in Land Logistics, beyond its use as simply a stakeholder 
engagement tool, DST Group should invest in developing AR for simulation, training and 
maintenance tools, as the three most viable applications relating to logistics. The state of 
AR hardware is currently sufficient to achieve these simple tasks, however some research 
needs to go into validating whether or not such technology and applications actually do 
increase productivity and effectiveness (such research was beyond the scope of this study). 
To us, this remains the main concern with AR technology: cutting through the hype, can 
AR be made useful in a practical sense? The DHL case study shows that it has potential. 
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Appendix A Help and Resources  

A.1 Websites 

The following websites were used throughout the project to assist with application 
development. 

Moverio YouTube channel 

• Has useful videos about app development basics specific to BT-200: 

• http://www.youtube.com/moverio  

Vuforia Website 

• Support Centre and Forums: https://developer.vuforia.com/support  

• Manage licenses and Targets: 
https://developer.vuforia.com/targetmanager/licenseManager/licenseListing  

Unity3D website 

• Forum and Answers sections: https://unity3d.com/community  

• Tutorials: https://unity3d.com/learn/tutorials  

Stack Overflow Website 

• Helpful for coding basics (C# and Java are the most common languages used for 
app development): http://stackoverflow.com/  

Android Studio website 

• Useful for Android specific application functions, contains an in-depth guide to the 
functions that are built into Android studio. http://www.androidstudio.com  

Udacity 

• Online training platform which offers free tutorials on various technologies and 
software, explicitly the Android basics courses, this course will teach someone how 
Android applications work and how to build them. http://www.udacity.com  

A.2 Common Issues Whilst Creating Apps on Unity3D 

The following troubleshooting techniques are intended to assist those new to Unity3D and 
application development. 

http://www.youtube.com/moverio
https://developer.vuforia.com/support
https://developer.vuforia.com/targetmanager/licenseManager/licenseListing
https://unity3d.com/community
https://unity3d.com/learn/tutorials
http://stackoverflow.com/
http://www.androidstudio.com/
http://www.udacity.com/
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Using the console: Use the console to debug your program (the tab next to “Project” at the 
bottom half of the screen). Debug.Log(variable OR “line of text to be displayed in 
console”); can be placed anywhere in your code to test if certain pieces are working 
correctly. 

GUI Labels/ Text Fields/ Buttons aren’t working/ appearing on screen: Graphical User 
Interface (GUI) functions must be called from the OnGui() function directly or from a 
method derived from it. OnGUI() is called every iteration of the program. 

Make sure the rectangle in which you are specifying the text location is within the 
dimensions of the screen. 

GPS doesn’t work: GPS tends not to work in editor even with Unity remote. Try it on the 
device and make sure location is on and wi-fi is on. If using mock location, turn off wi-fi 
(use mock location by enabling in developer mode and downloading a lock location app). 

A.3 Common Issues with Built App 

This section is more directed at the technicalities of getting an application onto an Android 
device. 

Not recognising device/downloading to device: Make sure the device is on and connected 
to the PC, developer mode is enabled and USB Debugging is on. 

Make sure the Application Programming Interface (API) is selected according to the 
version of Android on the device (see the inspector settings).  

How to build an App: Within Unity3D: 

• Go to File > Build settings > Switch Platform to Android Device. 

• Go to File > Build settings > Add Open Scenes (or at least one scene must be 
selected). 

• Go to File > Build settings > Player Settings > Bundle Identifier must be of form 
com.CompanyName.ProductName and neither your product or company name 
can have spaces. 

• Go to File > Build settings > Build and run. At this point it might ask you to save 
the build, this must be saved in the Assets folder, make a builds folder inside 
Assets to save all your builds in. 

Downloading but not working: If you are using a Vuforia plugin AR Camera you must 
enter a license key in the inspector, get this from your Vuforia account on the Vuforia 
website. Remember there are different license keys for mobile devices (i.e. Samsung Tab) 
and digital Eyewear (Moverio). 

When using AR Camera and Moverio Camera Rig on Moverio, the screen will be black 
with a vuforia icon in the corner. The app is waiting for a target to be detected which may 
take a little while. Remember the camera is on your right side. 
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Playing app on device without doing a full build: Download the Unity remote from the 
play store and connect the device to the computer and open the app. On the PC navigate 
to Edit > Project Settings > Editor > Device > Any Android Device. This is helpful as it 
allows you to utilise the sensors on the device and see how it will appear on screen and in 
the console without doing a full build. 
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Week 1-2 Research and 
testing 

Compile 
Moverio Info 

Doc 

Week 3-4 Produce application 
testing capabilities  Stock App 

Week 5 
Produce application 

relevant to Land 
Logistics  

MedicAssist 
App 

Week 6 Prepare report and 
presentation 

Appendix B Timeline 

Chelsea undertook a six week placement which followed the timeline below. 
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Matthew undertook a 12-week placement with the timeline below. 

 

•Get farmiliar with hardware 
•Research software available Week 1 
•Download required software 
•Get application on device Week 2 
•Continue building basic applications 
•Determin scope of project and set goals Week 3 
•Begin using built in sensors 
•Determin usablility Week 4 
•Continue onto more advance sensors (GPS) 
•Determin usability Week 5 
•Begin preparing presentation 
•Work on 3d visualisation application Week 6 
•Presentation to STC 
•Begin working on servicing application Week 7 
•Begin learning basic Android specific app development 
•Begin working on Android networking capability Week 8 
•Practice presentation 
•Continue with learning Android networking capability Week 9 
•Conference week 
•Site visit to SAAB Week 10 
•Finalising report 
•Cleaning up computer files ready for handover Week 11 
•Finalise report 
•Clean workspace and organise files/doccuments 
•Write instructions for running applications 
•Test applications on all devices. 

Week 12 
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